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Chapter 1
Compatibility Matrices

1.1. Hardware Compatibility
PSS®E 36 has been built to take advantages of modern chipsets. To that end, PSS®E 36 will only run on
CPUs that support, at the very least, the SkyLake micro-architecture. This is also referred to to as the AVX
instruction set. Building the program to require an AVX compatible CPU allows the compiler to take advantage
of improvements in floating point operations, the execution of which will benefit the PSS®E engine in all
types of simulations.

1.2. Python Compatibility
This section outlines compatibility for Python versions supported at different releases of PSS®E 36. An "X"
means that the matching version of Python (top row) can be used in a particular release of PSS®E 36 (left
column).

Table 1.1. Python Compatibility

 Python 3.11 (64-bit) Python 3.12 (64-bit)

PSS®E 36.0 X

PSS®E 36.1 X

PSS®E 36.2 X X

1.3. PSS®SINCAL Compatibility
This section outlines compatibility between PSS®E and PSS®SINCAL versions.

Table 1.2. PSS®SINCAL Compatibility

PSS®E GMB -
Using

models

License
needed

GMB -
Editing
models

License
needed

License
from

Eigen-
value

Analysis

License
needed

License
from

36.0 N/A N/A N/A N/A N/A N/A N/A N/A
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Chapter 2
Removed Utilities and APIs

The following utilities and APIs have been removed from the PSS®E 36.0 installer.

2.1. Removed Utilities

The following utilities have been removed with the official release of PSS®E 36.0:

1. Utilities that are used to convert RAW and SEQ files between different versions:

• CNV27

• CNV29

• CNV30

• CNV31

• CNV32

• CNVRAW

• CONVERTRAW

• CNVRSQ

The functionality of the above conversion utilities remain directly accessible from the PSS®E GUI,
File>Open, which can read any current or previous versions of the RAW and SEQ files.

These functions are also available through automation scripts: psspy.readrawversion(..), psspy.resqver-
sion(..), bat_readrawversion and bat_resqversion.

2. Utilities that are used to write previous versions of RAW and SEQ files:

• RAW23

• RAW26

• RAW28

• RAW29

• RAW30

• RAW31

• CREATERAW
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Removed Utilities and APIs Removed Application Program Inter-
face (API)

The functionality of these conversion utilities are directly accessible from the PSS®E GUI, File>Save Case
As..., which can write any current or previous versions of the RAW and SEQ files.

These functions are also available through automation scripts: psspy.writerawversion(..), psspy.writese-
qversion(..), bat_writerawversion and bat_writeseqversion.

3. Converting/writing power flow data, *.raw, and sequence data, *.seq, formats to versions 28 and prior
is no longer supported. We will continue to support reading raw and seq files from any prior version.

2.2. Removed Application Program Interface (API)
The following API functions have been removed starting with PSS®E 36.0.1:

1. psse36.set_minor()

The ability to programmatically set and initialize a specific version of PSS®E 36 via Python with the
psse36.set_minor() API has been deprecated and removed.

Due to underlying technical issues that prevent Python from loading the correct modules for the specified
version of PSS®E, this API will no longer perform any functionality when called. Existing scripts will not
break from this deprecation; a message will be sent to the active progress device when called.

The intended functionality of set_minor() will be reintroduced with a future release of PSS®E.
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Chapter 3
PSS®E 36.2.0 Release Notes

December 2024

3.1. Security Enhancements
The following changes have been made to address security and/or vulnerability issues:

1. Python

The default version of Python used with PSS®E 36.2.0 has been updated to Python 3.12 (i.e. the version
that is used by PSS®E interfaces without specifying a version with -pyver) to include functional and
security updates.

For compatibility while transitioning to Python 3.12, PSS®E 35.6.2 can start with Python 3.11 support
by overriding the -pyver flag in the shortcut or command used to launch PSS®E.

We do not expect any compatibility issues with the upgrade from Python 3.11 to Python 3.12.
An overview of what has changed in Python 3.12 is available from python.org at: https://doc-
s.python.org/3/whatsnew/3.12.html.

For additional Python compatibility information with PSS®E 36, Refer to Section 1.2, “Python Compati-
bility” for more information.

2. CodeMeter Runtime

The version of the CodeMeter User Runtime shipped with PSS®E 36.2.0 has been updated to version
8.20a.

A full list of changes included with CodeMeter 8.20a can be found under "Changelog for CodeMeter Run-
time" from Wibu-Systems at: https://www.wibu.com/us/support/user/downloads-user-software.html

Note
If network license capabilities are used with PSS®E, the respective license server responsible for license dis-
tribution will need to be updated to match the CodeMeter Runtime version used with PSS®E.

3.2. Program Enhancements
The following program enhancements appear in this release:

1. Short Circuit

• Added FLAT_3 api:

https://siemens-si-gsw.aha.io/ideas/ideas/PSSE-I-979 FLAT start option to reset tap ratios to nominal
winding ratio, not bus base voltage.
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PSS®E 36.2.0 Release Notes Program Enhancements

• added new options to set network elements: DC lines, FACTS devices, transformer zero sequence
impedance corrections and machine power

• added case values for existing options: transfomer tap ratio and phase angle, line charging,
switched shunt and transformer magnetizing admittance

• Enforced network setting options for a)set voltage to unity b) set classical short circuit assumptions
c)setup for IEC60909 calculations

• added "set user specifed network changes" option

• ASCC_3 activity: STATUS(15)=1 option that sets "LINE, FIXED AND SWITCHED SHUNTS, MAGNETISZING
ADMITTANCE OPTION" to 0.0 in the positive and negative sequences works differently on switched
shunts. It now sets switched shunt admittance to zero in positive and negative sequence but considers
in zero sequence. In previous versions STATUS(15)=1 always set switched shunt admittance to zero in
zero sequence. If used this option, ASCC_3 API results would be different.

ASCC_3 activity: When FLAT classical network changes applied, load option changed from "Set to 0.0
in the positive and negative sequeces" to "Set to 0.0 in all sequece networks". If used this option,
ASCC_3 API results would be different.

• Added compare_flat_scmu_ascc.py to Example folder. This file shows applying FLAT api network
changes and calculating SCMU activity fault currents. Calculate fault using activity ASCC with similar
network changes done in FLAT. The faults currents from SCMU and ASCC should be identical.

• In IECS activity, equation 24 of IEC 60909-0 standard calculates impedance correction factor KSO for
power station unit without OLTC, GSUType=2 in IEC data file. This equation was implementd with
(1+pT) factor. This is now changed to (1-pT) factor. This is done to get the highest partial short-circuit
current of the power station unit at the high-voltage side of the unit transformer with off-load taps
as recommended in IEC 60909. This will change IECS activity results from earlier versions for cases
when KSO is to be calculated and pT is specified.

2. Time Series Power Flow

• Added tspfdata Python module to generate timeseries domain RAWx files from Excel files that provide
curve set, time data and profile data information.

• Added tspf_excel2rawx_demo.py and tspf_excel2rawx_demo_data.xlsx files to Example folder to
demonstrate the use of tspfdata module.

3. Study Projects

• Study Project Tasks can now be offloaded to the PSSE Cloud if valid credentials are provided to PSSE
to utilize additional parallel processing computing power. The option also needs to be enabled in the
Study Project preferences, whcih can be set via API or Preferences dialog in the UI under "Edit->Pref-
erences...".

• Added ability to toggle the visiblity of the Study Project Tasks pane by going to "View->Study Project
Pane".

4. Slider Diagram
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PSS®E 36.2.0 Release Notes Aha! Ideas Portal

• In the auto-position and auto-rotation mode, labels maintain relative position and rotation when
moved.

• During the export of location files, the use of extended bus names can be enabled by modifying
the bus output options. Furthermore, when reading the location files, the extended bus names are
readable and can be used as bus identifiers.

• Machines now display a unique symbol depending on whether they are a conventional, renawable
or infeed machine.

5. excelpy Pyhon Module

• Updated PSSE installed excelpy Python module to not use PyWin32 module. Note that the pywin32
module will no longer be shipped with PSSE installer.

• excelpy module now uses another open source Python module, openpyxl. This module will be shipped
with PSSE installer.

3.3. Aha! Ideas Portal
The following items from the Aha! Ideas Portal are included in this release:

1. https://siemens-si-gsw.aha.io/ideas/ideas/PSSE-I-283 - Add ability to GOUT bus from associated node in
a substation diagram.

2. https://siemens-si-gsw.aha.io/ideas/ideas/PSSE-I-907 - Add an option for PSSE to automically display the
names of the system elements such as transmission lines, tranformers, shunts etc... on the slider dia-
grams. This can be accessed through the Annotation dialog on each piece of equipment.

3. https://siemens-si-gsw.aha.io/ideas/ideas/PSSE-I-547, https://siemens-si-gsw.aha.io/ideas/ideas/PSSE-
I-983 and https://siemens-si-gsw.aha.io/ideas/ideas/PSSE-I-1102 - Search bus names in slider diagram.
When selecting buses for locate, you can select toggle Names mode in the bus selector, effectively
searching for bus by name.

4. https://siemens-si-gsw.aha.io/ideas/ideas/PSSE-I-997 and https://siemens-si-gsw.aha.io/ideas/ideas/
PSSE-I-1061 - Machines with associated NCS data now display a green badge with the letter "N" on the
"stem" of the symbol.

5. https://siemens-si-gsw.aha.io/ideas/ideas/PSSE-I-1088 - The issue of animation arrows being obscured
by thick lines was resolved by positioning the animation arrows based on the line widths.

6. https://siemens-si-gsw.aha.io/ideas/ideas/PSSE-I-1118, https://siemens-si-gsw.aha.io/ideas/ideas/PSSE-
I-1060 and https://siemens-si-gsw.aha.io/ideas/ideas/PSSE-I-1059 - The dynamic spreadsheets now sup-
port the ability to popup the Network Data record dialog to see the element the model is attached to.
This will give visibility to associated bus numbers. Where applicable, an option to do a GOUT of the as-
sociated bus is also available.

7. https://siemens-si-gsw.aha.io/ideas/ideas/PSSE-I-1133 - The dynamic model edit dialog now has the abil-
ity to copy and paste into the fields on the dialog. This will be useful in copying example values from
the Model Library documentation (where applicable).

8. https://siemens-si-gsw.aha.io/ideas/ideas/PSSE-I-1085 - Show the line length on Tap line dialog.
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PSS®E 36.2.0 Release Notes Program Corrections

9. https://siemens-si-gsw.aha.io/ideas/ideas/PSSE-I-1111 - New API to 'Remove All Unbound Items from Di-
agram'. This function will remove all unbound network elements, both hidden and visible, from the ac-
tive diagram.

10. https://siemens-si-gsw.aha.io/ideas/ideas/PSSE-I-1179 - Switching the status on System or Station
Switching Devices now cycles through mode 2, Stuck Closed. A new diagram symbol, a Closed Switch
or Breaker with an X through it, indicates Stuck Closed.

11. https://siemens-si-gsw.aha.io/ideas/ideas/PSSE-I-1055 - Export/import settings files for all preferences.

3.4. Program Corrections
The following program enhancements appear in this release:

1. RAWX Extension

• Fixed an issue where bringing in a case without Extension data after a case with Extension data could
cause a crash when scrolling to the edge of the spreadsheet.

2. GIC

• Bug fix in saving GIC data to .sav file. This bug happens when GIC data file (.gic) contains transformer
record group, and does not contain branch record groups. After reading such GIC data file (.gic) file
and saving this working case to .sav file, transformer GIC data is not saved correctly. As a work around
run GIC analysis by reading GIC data from .gic file. If GIC data needs to be saved to .sav file, add at
least one branch record in GIC data file.

3. Node Breaker

• The issue with reading substation data from .rawx files has been addressed. Previously, text values
that had leading or trailing space characters were not being read correctly.

• Bug fix to eliminate potential crash in node-breaker topology when updating bus type codes or other
equipment statuses.

• Bug fix to eliminate the potential for bad values to appear after the node-breaker topology processor
is run. These values would be highlighted in red in the spreadsheet view. The original issue showed
up in system switching devices.

• Bug fix to prevent a terminal device (load, fixed shunt, switched shunt, machine, induction machine,
shunt FACTS) from being set to in-service when connected to an out-of-service node.

• Bug fix to prevent negative bus type codes after topology changes.

• Fixed circuit test on FACTs device to check on in-service status of series component.

4. Short Circuit

• Bug fix in ASCC_3 activity to correctly interpret default STATUS (=_i) array inputs. STATUS(5)=_i was
not selecting "SUBTRANSIENT" generator reactance.

• Bug fix reading sequence data file to avoid errors like "Warn: MOV flag is 1 but Z-zero
(.00000,-.253120E-1) is not equal to Z-pos (.00000,-.253120E-1)" when ZPOS and ZZER of branch
are compared.
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PSS®E 36.2.0 Release Notes Program Corrections

• Bug fix/update to disable use of arrbox.ascc_currents and arrbox.iecs_currents modules when case
has MOVs and/or NCS machines.

• Updated api manual to show all error codes in activities ASCC_3 and IECS_4; Python modules ar-
rbox.ascc_currents, arrbox.iecs_currents and arrbox.fault.

• Removed raise RunTimeError in ascc_currents and iecs_currents. Instead return object that contains
only error code. This helps in batch processing without interruption.

• Fixed bug that crashed program when adding NCS machines from spreadsheets. This bug occurred
when NCS machine is added from spreadsheets and NCS curve name is not specified.

• Fixed bug that crashed program when running arrbox.ascc_currents and arrbox.iecs_currents func-
tions. That crash happened when using RAW file (no sequence data) as network data to run these
functions.

5. GIC

• Example folder "gic_efield_grid.py" file updated to add following.

• Bugfix to use specified subsystem in GIC Efield Grid calculations.

• Added option to plot specified number of transformers with largest Effective GIC flows.

• Do not write GIC data check progress message for each efield grid file run.

• DO not write to progress file Ieff for each efield file run.

• Bug fix in arrbox/gicthermal.py module. The transformer IDs argument 'trnids' specified in plot_trans-
former_gict(..) method was not processed correctly.

• Bug fix in arrbox/gicmaps.py module. The legend marker size method updated to use latest matplotlib
method.

• Added Substation Earth Conductivity Models to GIC data file ieee_gic_test_case.gic.

6. Harmonics

• Bug fix in arrbox\harmonics.py module in processing voltage distortion THD and Individual Limits
plots. [IEEE 519 Standard Voltages limits were not accessed correcty.]

• Bug fix in Example\harmonics_demo_arrbox.py when processing returned objects from harob-
j.plot_vlt_dstn_indv(..). [Plot calls also return bar handles.]

• Updated Example\harmonics_demo.py file to use har_analysis_2 API.

• Bug fix - harmomincs limits voltage violations report. For report violations option 'Report all buses'
wrongly stated "NO VIOLATIONS FOUND" message.

7. Dynamic Simulation

• In the model library manual, fixed issues regarding some CON names for the dynamic models AC3C
and AC9C.
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PSS®E 36.2.0 Release Notes Program Corrections

• Updated WECCDS (data file converter from PSLF dyd to PSS®E dyr data records) to convert the PSLF
models esac1c, esac2c, esac3c, esac4c, esac5c, esac9c, and esac10c.

• Fixed an issue when performing STRT (dynamic simulation initialization) in the presence of generators
that are marked as in-feed machines in PSS®E powerflow. As a result of this issue, the generator model
attached to such a machine was not being recognized, and hence the machine was getting gnetted
with the machine being set to out-of-service.

• Fixed an issue (which was causing the program to crash) in writing out messages in the function that
does line switching operation during dynamic simulation.

• Fixed some issues in the dynamics models ST9C and SGT8HM1 that could potentially cause the pro-
gram (PSS®E) to crash.

• Fixed an issue in the VHVDC1 model documentation. The CONs J+45 and J+46 (dbd2r and dbd2i) of
this model are in units of MVAR. These were erroneously shown as being in per unit (pu).

• Changes in the way the DER MVA is calculated in the load individual component model DERAxx (xx
could be BL/OW/ZN/AR/AL).

• In the load individual component model DERAxx, added a check for the status of DER and exit the
model if the DER status is OFF.

• In the load individual component model DERAxx, added a check to exit the model if the DER MVA gets
reduced to zero due to DER tripping during simulation.

• In the load distribution component model DISTxx (xx could be BL/OW/ZN/AR/AL), added logic to set
the distribution feeder resistance (Rfdr) to zero if the feeder reactance (Xfdr) is less than the zero-im-
pedance threshold.

• In the VSC DC model VHVDC1, fixed an issue in the calculation of Qref when RefFlag is set to 2 (Power
factor control).

• In the electrical control model REECE, fixed an issue when PFFlag=0 and PEFlag=1 (the output of
block marked s1, which gets used by the PI-control block s7, was not getting updated for this flag
combination).

• Modified the REECU to output the model DYDA record in PSS®E version 36 format (i.e., without the
USRMDL keyword).

• Fixed an issue which was causing the simulation to crash when invoking the line trip model LINTRP.

• In the WECCDS program (program for converting PSLF dyd to PSS®E dyr format) fixed an issue in
writing out the value of VULMIN (CON(J+37)) for the UEL2C model. This parameter (which does not
exist in the PSLF uel2c model) was being written out by WECCDS as 0.0. This has now been changed
to -99.0.

• In the FACTS device model SVSMO3, reworded the message that is written out when the bus (to which
the FACTS device is connected) is not found or if the bus is disconnected or if the FACTS device is
blocked.

• In the WECCDS program, fixed some issues in the dyd to dyr conversion of pss4c and pss5c.
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PSS®E 36.2.0 Release Notes Program Corrections

• In the WECCDS program, fixed an issue in converting the value of SW1 for the dynamic model UEL2C>.

• Fixed an issue in the VHVDC1 model documentation. The CONs J+45 and J+46 (dbd2r and dbd2i) of
this model are in units of MVAR. These were erroneously shown as being in per unit (pu).

• Added the set APIs for the following: DC2SIG, DCMSIG, VSCSIG, FCTSIG.

• Added the get APIs for the following variables: NMACHS, NBUS, NLIN.

• In the VHVDC1 model datasheet, added the missing ICON(M+4) in the model ICON listing.

• Fixed an issue in the REGCC model. As a result of this issue, the drive train model (if present) could
have initialization issues (i.e., have suspect conditions) when used along with the REGCC model.

• In the L1PMxx (xx could be BL/OW/ZN/AR/AL) model documentation and code, fixed the description
of state(K+7).

• Fixed an issue in doing DOCU of switched shunt models.

• In the WECCDS program, changed conversion of PSLF exdc4 to PSS®E IEEET5 (instead of IEEET4) when
the exdc4 KR is zero.

• Fixed an issue preventing the editing of certain machine and wind machine model types from the
Dynamic spreadsheets.

• In the turbine governor models SGT2E1, SGT8HM1 and SGT8HS1, added logic in the model code and
also added a note in the model library documentation to make it clear that Pgfup and Pgfdown (CONs
J+21 and J+22 respectively) must be specified as positive values.

• In the AC8C model, fixed the descriptions of CONs J+6 and J+8.

8. Optimal Power Flow

• Fixed an issue in which the transformer turns ratio was set incorrectly in the OPF active and reactive
power loss solutions. This occured for any active transformers having a secondary winding value other
than 1.0.

9. Slider Diagrams

• Fixed an issue with Summations where extra text on a "equation" line would cause the From bus to
be the Metered end, regardless of what was specified.

• Fixed an issue with loading bars and the incorrect assignment of "S" or "I" to results depending on the
current as MVA or MVA setting. The "S" or "I" assignment was reversed.

10. PSSPLOT

• Fixed an issue where enabling/disabling "Chart Grid" from "Plot Book" menu was not working correctly.

• Fixed an issue where zooming out after using "Zoom Window" was not functioning as expected.

• Fixed an issue where deleting series caused axes names to get mixed up.

• Fixed an issue where removing a trace caused a random crash.
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PSS®E 36.2.0 Release Notes Known Issues

• Fixed an issue where plot_trace_purg api was being recorded with wrong parameters.

• Fixed an issue where using default parameters with plot apis caused a crash.

• Fixed an issue where plot apis were not recording the default plot name, page, plot and trace number.

• Fixed an issue where drawing the same channel twice resulted in one common axis.

• Fixed an issue where plot axes overlapped.

• Fixed an issue where active plot element changes made from the GUI was not effective.

• Fixed an issue where plot_page_chng api call was not updating the GUI view.

• Fixed an issue where plot_page_print was not using the filename parameter passed.

• Fixed an issue where channel file used in the python scripts was said to be not open even when it
was visible in plot tree view.

• Fixed an issue where closed and re-opened channel file was not visible in the plot tree view.

• Fixed an issue where PSSE was crashing when a script is run after calling the plot_plot_chng api.

• Fixed an issue where chard grid default value was set to minor grid when psse starts. Changed it to
be major grid which is the default.

• Fixed an issue where calls to dragdropplotdata and insertplot pssplot APIs was not working as expect-
ed.

• Fixed an issue where plotting two different channels from separate channel files with the same name
caused only the channel from the first opened file to be plotted.

3.5. Known Issues
1. There is a known issue involving crash when running dynamic simulation STRT and RUN when the 'En-

able interactive data checking' (under Edit>Preferences) and the 'Model Debug Output' (under Dynam-
ics>Simulation) options are selected. We are currently working on a fix for this issue. Until a fix is incor-
porated, the workaround is to disable the 'Enable interactive data checking' option.
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Chapter 4
PSS®E 36.1.0 Release Notes

July 2024

4.1. Security Enhancements

The following changes have been made to address security and/or vulnerability issues:

1. CodeMeter Runtime

The version of the CodeMeter User Runtime shipped with PSS®E 36.1.0 has been updated to version
8.10a.

A full list of changes included with CodeMeter 8.10 can be found under "Changelog for CodeMeter Run-
time" from Wibu-Systems at: https://www.wibu.com/us/support/user/downloads-user-software.html

Note
If network license capabilities are used with PSS®E, the respective license server responsible for license dis-
tribution will need to be updated to match the CodeMeter Runtime version used with PSS®E.

2. Intel oneAPI Fortran Runtime

• The Intel oneAPI runtime (formerly known as Intel Visual Fortran (IVF)) version included with PSS®E
36.1.0 has been updated to version 2024.2.0 to include functional and security updates.

Information regarding changes included in this updated runtime version can be found at https://
www.intel.com/content/www/us/en/developer/articles/tool/oneapi-standalone-components.html

4.2. Program Enhancements

The following program enhancements appear in this release:

1. Dynamic Simulation

• PSS®E dynamics engine enhancements to allow for adding VAR and STATE descriptions (similar to the
existing model CON and ICON descriptions) for every dynamic model.

• Added set API for setting the VAR and STATE description in user defined models.

• Added the Hybrid Plant Controller model HPLNTD model (this is same as the WECC approved model
REPC_D), and the local plant controller model REAXD which will receive signals from the HPLNTD
model.

• Added the WECC approved Virtual Synchronous Machine (VSM) based Grid Forming model REGFMB1.
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• Added the ability to perform step changes in real and reactive/voltage reference set points (Pref , QVref
signals respectively) of renewable models via GUI (under the Dynamics>Disturbance menu item) and
via python and idv APIs.

• Added a dynamic model (FLYWHL) to represent the Beacon Power flywheel.

• Added Example dynamics data for all the renewable models in the model library manual.

2. GIC Module

• Added following files to example folder to help setup and run near real-time GIC Efield Grid calcula-
tions.

gic_efield_grid.py

gic_efield_grid_gui.py

gic_efield_grid_setup.py

run_gic_efield_grid.pyw

3. Harmonics Module

• Harmonics Impedance Characteristics Data in harmonics data file specification changed from ratio in
terms of fundamental frequency values. This was unusable in most cases. The RN, X1N and X2N are
now specified in ohms at harmonics order N.

• Harmonics Distortion results include demand currents at bus [POI/PCC]. The bus current total harmon-
ics distortions and individual harmonic levels are reported.

• Added activities to report current and voltage violations as per IEEE-519 standard.

• Added functions to arrbox.harmonics module to create Python objects for multiple frequescy scan
and distortion calculation results.

• Added dialogs to harmonics menu to provide access to activities that export results to csv, current and
voltage violations reports, calculate short circuit levels at POI/PCC.

4. Study Projects

• Improved Task management.

• When changing Variants, related results files will be reloaded for that Variant.

• New Study Project category for text Report based APIs.

• Variants can now be cloned though Study Project Tree View.

• DIFF can be run between two arbitrary Variants though Study Project Tree View.

• Study Project can be deleted from the Start Page.

• Start Page can be closed to return back to Task view.
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5. Slider Diagrams

• Added feature to GoTo a Bus from the Branch context menu. Menu entry only visible when Bus is off-
screen.

• Loading Bars for items that having a rating of 0 will be automatically hidden.

4.3. Program Corrections

The following program corrections appear in this release:

1. Power Flow

• Corrected an issue where a new branch or transformer is not added correctly via user interface data
tables. The issue happens when 'enable interactive data checking' (under Edit>Preferences) is checked
and the new element has some data errors.

• Corrected an issue in sensitivity analysis where the tie lines are included when sensitivity factors are
calculated for branches in a subsystem.

• Corrected an issue that the transformer turns ratio may be set improperly with the direct tap adjust-
ment option in a power flow solution. Although the resulting turns ratio is able to regulate the con-
trolled voltage within the voltage limit, the controlled voltage may be away from the middle point of
the voltage limits which is the desired voltage with the direct tap adjustment option.

• Corrected an issue in contingency analysis solution where the solution may get stuck if infeed ma-
chines and other machines are connected to the same bus, and infeed machines have non-zero Qmax
and Qmin.

• Corrected an issue in contingency analysis solution where the solution may crash if the python-based
RAS is present and phase shift option is enabled.

• Corrected an issue where power flow solution may not converge if the voltage droop control has zero
voltage deadband(Vdblow equal to Vdhhigh), and the regulated voltage is close to the Vdblow.

• Allow the following contingency definitions for switched shunts to omit the ID field, which will be
assumed to be "1 ": ADD, REMOVE, SET, CHANGE, ISOLATE.

• Corrected an issue with contingency analysis solution. When the base case has node breaker data and
the substation switching devices are monitored in the .mon file, parallel contingency analysis solution
and single contingency run reporting may crash.

• Corrected an issue with bus name ordering for cases that contained 3-winding transformers and also
contained bus names that started with characters that not defined within the 7-bit ASCII character
encoding standard.

• Corrected an issue in arrbox.dfax_pp. The summary object of DFAX_PP did not return monitored ele-
ments.

• Corrected an issue involving a constant increase in memory usage during the process of reading "json"
formatted files. This issue was revealed reading 1000s of NOAA/SWPC efield grid map data files during
GIC analysis.
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2. Node-breaker modeling

• Corrected 2-terminal, multi-terminal, VSC and FACTS device converter bus assignments to reflect the
proper bus section. When a bus is split due to operations of switching actions, any connected rectifi-
er/inverter buses of 2-terminal DC lines, converters of VSC DC lines, converters of multi-terminal DC
lines, or the sending/terminal bus of FACTS devices now reflect the proper bus section of the node
specified. Prior to this correction, the bus section with the smallest node number would always be
assigned.

3. Dynamic Simulation

• Corrected an issue that could, in certain situations, cause PSS®E to crash when the API psseinit() is
called after the API pssehalt_2().

• Added the following get APIs for use in user defined models: get_BSWICH, get_ZERNUM, get_B2S,
get_ITER, get_SHFRST, get_SHNEXT, get_SHNTID, get_FCSHMX, get_FCVSET.

• Added the set APIs for VSCPAC, VSCQAC, VSCTYP, OLDERV, and MDC

• Exposed the following functions for use in user defined models: PTOTxx (xx coule be OW, ZN, AR or
AL), SWCAP.

• Added a function UEL2CUDM for users who were using the PSS®E library model UEL2C in their user
defined models.

• Fixed an issue in doing subsystem based DYDA for dynamic models associated with switched shunt
and induction motor.

• Fixed an issue in converting the PSLF load model model wlscc to the PSS®E model IEELAL.

• Fixed several issues related to interactive DOCU checks of load characteristics, load relay and load
component models.

• Fixed several issues related to load characteristics, load relay and load component model display in
the Dynamics and Model tree view.

• Fixed several issues related to DOCU check of load characteristics, load relay and load component
models.

• In the weak grid model WTGWGOA, fixed a crash issue in writing out some warning message during
initialization.

• Fixed an issue in doing interactive data checks for the Weak Grid and Paux (IBFFR) type renewable
models.

• Fixed an issue in writing out the model names of load component models when using the DYDA
activity.

• Fixed an issue in the load individual component model DERAxx (where xx could be BL/OW/ZN/AR/AL).
This issue could potentially crash PSS®E during initialization when the model writes out a message
about LfDER being zero.

• In the renewable plant control model model REAXB1, added logic to check and write out messages
should the initial model output be outside the specified limits (Wmax, Wmin, Pmax and Pmin).
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• In the renewable plant control model model REAXB1, fixed an issue that could crash PSS®E when
using activity DYDA to write out the model DYR record.

• In the power system stabilizer models PSS2A, PSS2B, and PSS2C, added docu check logic to check for
Tw4 and T6 (i.e., CONs J+4 and J+2) only if these are not specified as zero.

• Fixed an issue in the conversion of CHRICN assignment statements to the Version Independent form
using the ‘VINDP Model Code Converter’ in the Environment Manager (EM). To get this fix, we suggest
upgrading to EM version 10.0.3 or above.

4. RAWX Extension

• Corrected an issue where importing a partial RAWX data set lead to the deletion of records in custom
defined fields.

• Corrected an issue where custom fields from RAWX were incorrectly displayed in the Network Data
Record table.

• Corrected an issue where only string type custom fields from RAWX were preserved when saving or
exporting data via readrawx API.

5. Non-Engineering

• Corrected an issue that prevented PSS®E 36 from launching on AMD based chipsets.
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Chapter 5
PSS®E 36.0.2 Release Notes

May 2024

5.1. Security Enhancements
The following changes have been made to address security and/or vulnerability issues:

1. CodeMeter Runtime

The version of the CodeMeter User Runtime shipped with PSS®E 36.0.2 has been updated to version
8.10.

A full list of changes included with CodeMeter 8.10 can be found under "Changelog for CodeMeter Run-
time" from Wibu-Systems at: https://www.wibu.com/us/support/user/downloads-user-software.html

Note
If network license capabilities are used with PSS®E, the respective license server responsible for license dis-
tribution will need to be updated to match the CodeMeter Runtime version used with PSS®E.

2. Python

PSS®E 36.0.2 ships with Python 3.11.9 to include functional and security updates.

A full list of changes included with Python 3.11.9 is available directly from Python.org at:
https://docs.python.org/release/3.11.9/whatsnew/changelog.html#changelog

3. Intel oneAPI Fortran Runtime

• The Intel oneAPI runtime (formerly known as Intel Visual Fortran (IVF)) version included with PSS®E
36.0.2 has been updated to version 2024.1.0 to include functional and security updates.

Information regarding changes included in this updated runtime version can be found at https://
www.intel.com/content/www/us/en/developer/articles/tool/oneapi-standalone-components.html

5.2. Program Enhancements
The following program enhancements appear in this release:

1. Power Flow

• Updated Fetch API to return terminal nodes of FACTs, DC line, VSC DC line, and multiple terminal DC
line

• Added following files to example folder:
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fault_calcs_off_nom_turns_3wdg.raw

fault_calcs_off_nom_turns_3wdg.seq

fault_calcs_off_nom_turns_3wdg.sav

fault_calcs_off_nom_turns_3wdg.py

ncs_calculations_pag_example_savnw.py

read_rawx_json_file.py

2. WECCLF and WECCDS

• Allow processing PSLF EPC file version 23.x. and PSSE RAWx file version 36.x.

• Add writing PSSE version 36.x RAWx file.

• Write all RAWx records groups, even empty records.

• Corrected issue in writing RAWx new bus record added for EPC data a) with zero bus number three
winding transformer tertiary winding, b) GCD and c) multi section lines.

• Actually following two changes were gone in 36.0.1, but were not mentioned in release notes.

When qtab=0 OR EPC generator cont_mode=1, then comment GCAP curve for that generator in PSSE
GCAP file.

Use keyword argument add_nb_data=True to write Node Breaker data from PSLF EPC file to PSSE RAWx
file in ndppslf.pslf2psse(..).

• Updated WECCDS (data file converter for converting PSLF dyd to PSS®E dyr data records) to convert
the PSLF excitation system model esac7c.

3. RAWX Improvements

• Efficiently reading RAWX files containing Node-Breaker data, resulting in significant reduction of pro-
cessing time from hours to minutes.

5.3. Program Corrections

The following program corrections appear in this release:

1. Power Flow

• Corrected an "Invalid Integer value detected" message when changing an Interface Type on the spread-
sheet.

• Corrected an issue that the interface type of an existing interface flow can not be changed.

• Corrected an issue that the transformer turns ratio may be set incorrectly with the direct tap adjust-
ment option in a power flow solution.
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• Corrected an issue where a new branch or transformer is not added correctly via user interface data
tables. The issue happens when 'enable interactive data checking' (under Edit>Preferences) is checked
and the new element has some data errors.

2. Node-Breaker

• When opening a PSS®E RAW data file generated from a solved case that includes substation buses
that have been split into sections, the bus section voltages now represent a solved case. Prior to this
fix, a solve needed to be performed after the PSSE RAW file was read in.

• Sporadic negative Bus Code values after the node-breaker topology processor runs has been corrected.

3. Short Circuit

• Corrected an issue in activity IECS. It affected LG and LLG fault currents in cases comprising 3 winding
transformers with two digit connections codes. Correction: For three winding transformers with two
digit connection codes (CC=11 through CC=18), calculate IEC 60909 impedance correction factors
(KT) considering zero sequence input data values X012, X023 and 031. Then apply KT factors to zero
sequence Z012, Z023 and z031. The error was: KT factor calculated considering positive sequence
X12, X23 and X31 were used to update zero sequence T-model parameters Z01, Z02 and Z03.

• Corrected an issue in obsolete api "SEQ_NCS_FLT_CNTRB_DATA" incorrectly calling api "SE-
Q_MACHINE_NCS_DATA" that caused the program to crash.

• Corrected an issue in api "SCEQ". The read change raw file created by SCEQ was in version 35 format.
This is corrected to write read change raw file in version 36 format.

4. GIC

• Corrected an issue in activity GIC. The error occurred when GIC analysis is done with options degree
scan and degree scan step size of 1 degree.

• Corrected an issue in activity GIC. The error occurred when GIC analysis is done with option solve
power flow. It produced lots of load addition warning progress errors for not correctly specifying load
name as required in v36 format.

5. ALA

• Corrected an issue with options logic.

Corrected an issue with ACCC hanging.

6. Dynamic Simulation

• Corrected an issue dealing with the output messages written out by load component models.

• Corrected an issue in the logic for tripping of the 3-phase motor load component model (L3PMxx - xx
could be BL, OW, ZN, AR or AL) by relay actions in the L3PMxx model.

• Added the missing logic in the dynamics engine to avoid displaying the load component model CON,
STATE, VAR and ICON as being unassociated in the dynamic tree GUI.

• In the excitation system model AC9C, added the missing logic to save the rate feedback output signal
(VF). This signal may be needed in some UEL models and hence saving VF was a must.
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• Corrected an issue while reading the dyre data record of the compensator model CCOMP4A.

• The PSS®E bus renumbering activity (RNFI) for renumbering bus numbers was not able to handle any
of the dynamic models added in the past several years. This has now been fixed.

• Corrected an issue reading/writing Event Study files. Reading a file would generate an error, noting
an attempt to read beyond the end of the file.

• Modified some formatting to prevent either a crash or to prevent the output from appearing as '****'
when writing out the ID and IQ values in the Machine Initial Conditions report following the execution
of activity STRT.

• Fixed an issue involving a crash in the PSS®E function "dyn_add_shunt" when this function is used by
dynamic models to add a new fixed shunt.

• In the PSS model IEEEST, fixed an issue with a warning message - if T5 (which is CON(J+10) of this
model) was zero, the model was erroneoulsy putting out a message regarding T3 (i.e., CON(J+8) of
the model).

• In the WECCDS converter, fixed issues in conversion of the following PSLF models - lsdt2 and esac2a.

• In the Program Operation Manual, chapter on 'Dynamic Simulation Activity Description', fixed an issue
in the DYR data record format for user-written load component type models (Main Model, Distribution
model and the Individual component models).

7. Optimal Power Flow

• Corrected a cosmetic issue in the OPF Linear and Quadratic Cost Tables where the Label column was
displaying only the first letter of the cost table name.

8. RAWX Improvements

• Fixes for clearing extension columns when reading in new data.

• Fixes for retaining extension data when reading update data.

9. Slider Diagrams

• Corrected an issue with reporting of MSLs when listing missing items in diagrams. Also addressed
formatting of several error messages.

• In certain iterations of Intel graphics drivers, an issue arose wherein attempting to select a specific
component on the diagram resulted in the selection of arbitrary components. This issue has been
resolved through the implementation of a workaround within the PSS®E system.

• Corrected an issue related to the export functionality of diagram to .jpg files. The quality parameter,
previously non-functional, is now operating as expected.

10. WECCLF

• Corrected an issue - ndppslfepc_nb.pyd file was missed from installed files.

11. Python
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• Corrected an issue where the dyntools Python module would display an incorrect error message when
there was an issue processing an extended dynamics channel output file (*.outx)

• Corrected an issue where the agcapcount() API could potentially raise a Python Exception regarding
a NULL object passed to Py_BuildValue.

• Corrected an issue where the agcapcount() API could potentially cause PSS®E 36 to abruptly close if
GCAP data exists in memory.

• Corrected an issue where cliplu.py, cload4.py, clpssusr.py, and cmdlusr.py could potentially throw a
Python exception when calling psse_env_manager.compile() and psse_env_manager.create_dll().

12. Non-Engineering

• Corrected an issue where saving network data to RAW file versions 33, and earlier, would not finish
completely and display a "Memory allocation error" message to the current progress device.

• Corrected an issue that prevented the PARSEXT executable from exporting proper paths for Python
installations newer than Python 3.7.

• Corrected an issue that prevented IPLAN users from being able to call any of the "User-Defined Rou-
tines".
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Chapter 6
PSS®E 36.0.1 Release Notes

February 2024

6.1. Security Enhancements
The following changes have been made to address security and/or vulnerability issues:

1. CodeMeter Runtime

The version of the CodeMeter User Runtime shipped with PSS®E 36.0.1 has been updated to version
8.00 for mitigating several issues that could potentially occur with licensing activity.

A full list of changes included with CodeMeter can be found under "Changelog CodeMeter Runtime"
from Wibu-Systems at: https://www.wibu.com/us/support/user/downloads-user-software.html.

Note
If network license capabilities are used with PSS®E, the respective license server responsible for license dis-
tribution will need to be updated to match the CodeMeter Runtime version used with PSS®E.

2. Python

PSS®E 36.0.1 ships with Python 3.11.7 to include functional and security updates.

A full list of changes included with Python 3.11.7 is available directly from Python.org at:
https://docs.python.org/release/3.11.7/whatsnew/changelog.html#changelog

6.2. Deprecated Functionality
The following features are considered deprecated as of PSS®E 36.0.1:

1. psse36.set_minor()

The ability to programmatically set and initialize a specific version of PSS®E 36 via Python with the
psse36.set_minor() API has been deprecated and removed.

Due to underlying technical issues that prevent Python from loading the correct modules for the specified
version of PSS®E, this API will no longer perform any functionality when called. Existing scripts will not
break from this deprecation; a message will be sent to the active progress device when called.

The intended functionality of set_minor() will be reintroduced with a future release of PSS®E.

2. Model Management add-on Python Module

Support for the Model Management add-on Python module has been removed.
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3. Due to an external dependency, plot APIs do not perform any functionality when called from outside
of psseXX.exe. This means that the plot scripts can only be performed through psseXX.exe. Otherwise,
error message will be sent to the active progress device.

6.3. Program Corrections
The following program corrections appear in this release:

1. Power Flow

• When the regulated bus of a voltage droop control is connected to zero impedance lines, and there
are transformers between generators in the voltage droop control and zero impedance lines; power
flow solution may fail to apply the voltage droop control.

• An issue with python-based RAS has been fixed. It may happen when adjust phase shift option and/
or tap adjustment option are enabled in a contingency solution with python-based RAS.

• Bug fixed - Activity RDEQ crashed PSSE when option "Suppress equivalence of controlled buses" was
enabled (=1) in some network cases with switched shunts controlling remote buses.

• When bus parameters other than voltage are changed, the voltage may change slightly too due to the
truncation error of single precision real number; this has been fixed.

• When a bus is deleted from the working case, the regulated bus in voltage droop data record may be
changed incorrectly. This has been fixed.

• An issue has been fixed where a three-winding transformer can not be moved.

2. Node-Breaker

• The Normal Status of system switching devices can now be obtained from a script command. Use
'NSTATUS' as the String argument to the BRINT API for individual system switching devices, and ABRINT
for multiple system switching devices. Additional Flag values of 7 and 8 have been added to the ABRINT
call to return only in-service system switching devices or to return all system switching devices. The
NSTATUS value of other branch devices has no meaning and will return zero.

3. Contingency Analysis

• When importing an incremental saved case from PV/QV an incremental saved case file, the transfer
level or voltage set point is not shown correctly. The issue has been fixed.

• Importing an incremental saved case file that was created by version 35 may crash the program, it
has been fixed.

4. ALA MUST

• Bug fixed for MUST options.

5. Short Circuit

• Bug fixed - Activities SCMU and ASCC fault currents resulted in NaN when NCS machine fault reactive
current contribution Iq was more than IFmax setting (PU maximum total current magnitude allowed
during a fault). In this condition Iq is set to IFmax and fault active current contribution Ip set to 0.
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6. Harmonics Analysis

• Bug fixed - harmonics analysis GUI dialog did not pass transmission line model and induction machine
model type selection correctly.

• Bug fixed - Corrected harmonics data model type 'infinite' integer value specified for generators (=7),
FACTS shunt devices (=7) and induction machines (=4). Corrected harmonics data manual to reflect
this.

7. Dynamic Simulation

• In the Hitachi model HVDCLIGHT1, added the fix supplied by Hitachi on November 10, 2023.

• Fixed a typo in the REPCC model documentation (in the part dealing with the MSS switching logic
scenario).

• Fixed an issue in reading in the PSS®E standard library model PFQTYP2. As a result of this bug, the
PFQTYP2 (which is a Power Factor Controller) model would should up as a Stator Current Limiter
model.

• In the REGFMA1 model, fixed an issue in writing out the DOCU of the model ICON - as a result of this
bug, the model DOCU would write out only one of the two ICON values.

• In the BASOEL2 model, fixed an issue dealing with the model ICON descriptions.

• In the load component model L3PMBL, fixed an issue in the model name.

• In the model library documentation of the Renewable Generator model REGFMA1, added minor clar-
ifications in the model notes section.

• Fixed an issue in invoking WTGIBFFRA from WTGIBFFRAU (i.e., from the "U" version of that model).

• In the renewable model WTGIBFFRA, fixed an issue in retrieving and displaying the model ICON de-
scriptions.

• Fixed an issue in displaying the standard library models of Load Main and Load Distribution component
in the Models Tree View of the GUI.

• Minor changes in the description of ICON(M+4) in the REPCA model documentation.

• At version 36.0, the excitation system models in the PSS®E library were all modified to account for the
output from the power factor controller model. We forgot to mention this in the “Dynamics Program
Enhancement” section of the release notes of version 36.0.

• Fixed an issue adding load and composite load models with an "*" as an Id.

• In the Vendor Library Model documentation for the GE Vendor model GEWT2MU1, since the model
uses only 3 VARs, the VAR(L+3) was removed from the table of VARs in the model data sheet.

• The generic renewable electrical control model REECE was added into PSS®E library at 36.0. However,
the block diagram was missing from the model library manual. This has now been added.
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• In the model library documentation of LCFB1 model, removed the wording "this model can be used
with...". Reason being that there is now no restriction on the governor models which can work with
the LCFB1 model.

• The SMA model documentation was missing from the Vendor Library documentation of 36.0. This
has now been added.

• Added a note about Vestas withdrawing support for their vendor specific models.

8. RAWX Extension

• Corrected an issue where importing RAWX data from a CSV file would force all character strings to
lowercase.

• Corrected an issue where RAWX table names could potentially not be displayed properly on the dialog
for importing RAWX data from a CSV file.

• Corrected an issue where RAWX table names could potentially not be displayed properly on the dialog
for exporting RAWX data to a CSV file.

• Corrected an issue where Harmonics RAWX data would not be read if Impedance Characteristics, Volt-
age Source, or Current Source data was missing from the file.

9. Slider Diagrams

• Slider Diagram label selection and font issues are fixed.

• Redraw FACTS devices when their configuration is changed.

10. PSSPLOT

• Corrected an issue about SCAN results using filter quantities not giving correct results.

• Fixed a crash that occurred when closing a plot book.

• Fixed "OPENCHANDATAFILE" API is not being recorded in automation files.

• Fixed "PLOT_PLOT_CHNG" API creating an unwanted new line.

• Fixed X-Y plot trace color being faint.

• Corrected an issue where deleting the only series in the plot did not remove the left Y-axis label.

• Fixed enabling or disabling tooltips, accessed by right-clicking on a plot, not working.

• Fixed zoom toolbar remaining open when there is no plot on the page.

• Corrected an issue where closed channel files showing up in "Channel Files" after a script execution.

• Corrected an issue where harmonics analysis results could not be plotted.

• Corrected an issue where running voltage violation from the plot menu caused a crash.
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• Fixed a typo when right-clicking on a "Plot Page", correcting "Close all plots" and "Close all plots but
this" to "Close all pages" and "Close all pages but this".

• Fixed overlap issue with 'Arithmetic Function' text and input field in "Add Function Dialog".

• Removed nonfunctional "Select" buttons from "Channel Selection Dialog".

• Bug fixed - When doing Voltage Violation Plots, clicking 2nd Limit standard crashed PSSE

• Bug fixed - When doing Voltage Violation Plots, clicking None Limit standard crashed PSSE

11. Non-Engineering

• Calling ACTIVITY HELP via the PSS®E Line Mode Interface (LMI) will now display correct help content
instead of "NO INFORMATION."

Files within the PSSHLP directory were erroneously not included with the PSS®E 36.0.0 release and
have been supplied with PSS®E 36.0.1.

• Corrected references to import psse35 in files supplied in the EXAMPLE directory.

• Corrected an issue where certain subsystem data retrieval APIs would display "final M:" when executing
from an external runtime environment (e.g. CMD or Python).
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Chapter 7
PSS®E 36.0.0 Release Notes

November 2023

7.1. Upgrading from version 36 Preview to version
36.0.0 release
Due to finalization of version 36 saved case format, the example directory in defined PSS®E HOMEPATH must
be reset. [File >Reset Example Directory]

7.2. Power Flow Data (RAW and RAWX formats) File
Changes
1. Added following new records

• SWDRATNAM records to System-Wide Data

• Voltage Droop Control Data

• Switching Device Rating Table Data

• Load Type Data

• Interface Data

• Interface Element Data

2. Added 'NAME' data item to following records

The 'NAME' is up to 40 characters or blank. If not blank, it must be unique for the devices in the same type.

• Load Data

• Fixed Bus Shunt Data

• Generator Data

• Switched Shunt Data

• Induction Machine Data

3. Added new data items to following records

• 'DROOPNAME' (Voltage Droop Name) added to generator data

• 'BYPASS' option added to branch data
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4. Following records format changed to use Switching Device Rating Table Data

• System Switching Device Data

• Station Switching Device Data

7.3. Sequence Data (SEQ format) File Changes
1. Following records were added at PSSE 35.2. These are now default version 36 format records.

• Non-Conventional Source - Fault Contribution Characteristics Data

• Non-Conventional Source - Generator Data

7.4. Security Enhancements
The following changes have been made to address security and/or vulnerability issues:

1. CodeMeter Runtime

The version of the CodeMeter User Runtime shipped with PSS®E 36.0.0 has been updated to version
7.60d.

A full list of changes included with CodeMeter 7.60d can be found under "Changelog for CodeMeter Run-
time" from Wibu-Systems at: https://www.wibu.com/us/support/user/downloads-user-software.html.

Note
If network license capabilities are used with PSS®E, the respective license server responsible for license dis-
tribution will need to be updated to match the CodeMeter Runtime version used with PSS®E.

7.5. Program Enhancements
The following program enhancements appear in this release:

1. Power Flow enhancements

• Bypass option is added for branch records. When bypass flag of a branch is enabled, the branch is
treated as an zero impedance line by power flow solution and other activities.

• Each device (machine/load/fixed shunt/switched shunt/induction machine) can have a name up to
40 characters or blank. If not blank, it must be unique for the devices of the same type. The API is
provided to find the device by device name.

• A load type table is added. Each load type has a unique name of 12-characters and description of 72-
characters. Loads can be assigned to a load type or None, and the loads can be grouped by a load type.

• Interface flow model is added. Each interface flow model may include multiple interface elements,
interface element could be one of branch, two winding transformer, three winding transformer, two
terminal DC line, VSC DC line, load, generator, or area tie etc. Either MW or MVAr flow of an interface
model can be monitored. Each interface can have up to 12 rating sets, each of them includes the
maximum and minimum limits
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• Every system switching device and substation switching device can have up to 12 rating sets. The 12
switching device rating sets have editable name and description fields.

• Switching device rating table is added. Each table is identified by a 40-characters table name and has
12 rating sets. Multiple switching devices include system switching devices and substation switching
devices can be assigned to a rating table.

• A separate designated rating set is provided for switching devices to calculating loading percentage.

• Interface flow limit checking function is added to report interface flow overloads.

2. Python

• PSS®E 36 defaults to the 64-bit version of Python 3.11. Earlier versions of Python which no longer
have active installer support for security fixes are not supported with PSS®E 36.0.

• PSS®E 36 no longer requires the wxPython module as a prerequisite. The following applications have
been rewritten to use the Tkinter module, a Python interface to the Tcl/Tk GUI toolkit, which is included
with the default installation of Python:

• PSS®E Excel Export

• WECCLF Converter

• PSS®E Environment Manager 10.0 (and newer)

Minimizing the dependency on third-party modules allows PSS®E to support the latest versions of
Python quicker. If desired, third-party modules (such as wxPython) can be installed separately from
PSS®E for use with Python (e.g. by using the Python PIP module).

Note
Siemens and PSS®E do not guarantee compatibility with third-party Python modules and that installation of
such modules is done at the discretion of the user. Licensing agreements are independent of those supplied
with PSS®E supplied software.

3. GIC Analysis

• Updated Space Weather Prediction Center (SWPC) URL that provides Geoelectric Efield Grid data de-
rived using Fernberg 1D Earth Conductivity Model.

• Corrected writing branch and transformer X/R ratios data to GIC maps (.pygic) file. This lead to error
reading this file by GICMAPS module

• Corrected legend markers function from latest matplotlib LINE2D attributes in GIC network map plots
drawn by GICMAPS module.

• Updated Example\gic_demo.py to add Efield Grid GIC calculations and drawing GIC(t) thermal plots.

4. Dynamics Enhancements

a. Added the WECC approved Renewable Generator/Converter Droop based Grid Forming Model REGF-
MA1.
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b. Version Independent (VINDP) User-Defined Dynamic Models (UDM)

A key feature of version 36 is the ability to create PSS®E Version Independent (VINDP) dynamic linked
library (dll). As a result of this development, dynamic UDM dll created using PSS®E 36 can be used
in all future versions of PSS®E. The highlights of the VINDP method of creating UDM are as follows:

• UDM will no longer have direct access to PSS®E data structures (like bus voltage, model CON, ICON
etc.) via COMON4.INS. Instead, UDM will access the PSS®E data structures through dedicated set
of APIs (called pssdm API) which are documented in the PSS®E API manual. Starting PSS®E version
36, COMON4.INS will not be available for use in UDM.

• Pre-version 36 UDM must be converted to the new VINDP form. To do this, a Python based UDM
converter is provided as part of the Environment Manager (EM) version 10.0 and above. Once
the UDM is converted to the VINDP form, as before, the UDM code can be compiled and the dll
can be created using the EM. This dll will be version independent, meaning that the dll can be
used in PSS®E versions 36 and above as is without the need for recompilation of the UDM code.

c. CONEC and CONET Removal

CONEC and CONET are not supported any longer. This implies that starting PSS®E 36, users will not
be able to use CONEC and/or CONET called models. In view of this, CONEC and/or CONET called
models, if present, must be converted to a form that does not require such calls.

The flow chart below shows the general migration path users should adopt if they have CONEC and
CONET called models in their dyr files.
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Set up has CONEC 
and/or CONET called 

models?

Yes

No

Input dyr file

Convert CONEC and CONET 
models to dll type models 

(models that do not require 
calls in CONEC or CONET)

dyr file has user 
defined models?

Yes

Use VINDP converter (in 
Environment Manager) to 

convert model to VINDP form

Is the user model in 
Version Independent 

(VINDP) form?

No

Details of converting CONEC and/or CONET called models are available in a document titled
"changes in CONEC CONET models-v03.pdf" posted on the PSS®E user support web page.

d. LPDEV Removal

The common method generally adopted by users to write to progress was through the the use of
unit number defined in the variable called "LPDEV". Internally this would involve a temporary file
(corresponding to unit number defined by LPDEV) being created and subsequently flushing the
contents of the temporary file onto the PSS®E progress output. This was slowing down PSS®E and
sometimes the messages would appear long after the simulation time has elapsed. To avoid this,
the use of LPDEV has been discontinued. Instead user models will now have to write to a buffer
(called DBUF01) and then use a PSS®E function (called PROGRESS) to flush the contents of DBUF01
(which is in the PSS®E memory) to the PSS®E progress output.

The general structure of a PSS®E write statement meant for output to the progress window would
now look as follows:

WRITE(DBUF01, format_statement) output_data
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call PROGRESS(dbuf01,number_of_lines_of_dbuf01)

where, 'format_statement' is the format statement number to write the 'output_data' into the buffer
DBUF01, and 'number_of_lines_of_dbuf01' stands for the number of lines in the buffer DBUF01
that need to be flushed out via call to PROGRESS.

e. The following models which were supplied as PSS®E Library user models (i.e., models required key-
words like 'USRMDL' in the dyr record) have been converted to PSS®E Library Standard models with
new model names. The table below shows the correspondence between the old (Pre-36) model
name and the corresponding version 36 model name.

Although the model names have been changed, users can continue using the old model names as
is (i.e., users do not have to change the dyr data file). PSS®E will take care of calling the new models
internally. When writing out the dyr records of any of these models (via activity DYDA), PSS®E will
output the dyr records with the revised model names.

Pre-36 Model Name PSS®E 36 Model Name

Generator Models

GENQECU GENQEC

Stabilizer Models

PSS3CU PSS3C

PSS4CU PSS4C

PSS5CU PSS5C

OEL Models

OEL3CU OEL3C

OEL4CU OEL4C

OEL5CU1 OEL5C

BASOELU2 BASOEL2

AVR Models

AC10CU AC10C

ST2CU ST2C

ST3CU ST3C

AC8BBU2 AC8BB2

Turbine-Governor Models

GOVSTEAMEUU GOVSTEAMEU

HYGOVR1HU HYGOVR1H

HYGOVWU HYGOVW

HYG3HU HYG3H

H6E1HU H6E1H

Power Factor Controller Models

PFQTYP2U PFQTYP2

2-Terminal HVDC Line Models

CHVDC2U1 CHVDC2

VSC DC Line Models
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Pre-36 Model Name PSS®E 36 Model Name

VHVDC1U VHVDC1

FACTS Device Models

HICOFCTU HICOFCT

Renewable Generator Models

REGCBU1 REGCB1

REGCCU REGCC

Renewable Electrical Control Model

REECDU1 REECD

REECEU REECE

Renewable Drive Train Models

WTDTBU1 WTDTB1

Renewable Pitch Control Models

WTPTBU1 WTPTB1

Renewable Aero-dynamic Models

WT12A1U_B WT12A1B

Renewable Plant Control Models

REAX4BU1, REAX3BU1 REAXB1

REPCCU REPCC

Renewable Weak Grid Models

WTGWGOAU WTGWGOA

Renewable Paux Controller Models

WTGIBFFRAU WTGIBFFRA

Machine Protection Models

MCREPWU1 MCREPW1

NRCGP3U NRCGP3

VPERHZU1 VPERHZ1

Bus Other Models

PLNTBU1 PLNTB1

GETBUSPHSVLTU GETBUSPHSVLT

GETBUSSEQVLTU GETBUSSEQVLT

Machine Other Models

GETGENSEQCURU GETGENSEQCUR

Branch Other Models

GETBRNSEQCURU GETBRNSEQCUR

Load Main Component Models

MAIN10xxU (xx can be BL, OW, ZN, AR, AL) MAINxx10

Load Distribution Component Models

DISTxxU (xx can be BL, OW, ZN, AR, AL) DISTxx

Load Individual Component Models

L3PMxxU (xx can be BL, OW, ZN, AR, AL) L3PMxx

L1PMxxU L1PMxx
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Pre-36 Model Name PSS®E 36 Model Name

LSTCxxU LSTCxx

LELCxxU LELCxx

DERAxxU DERAxx

7.6. Program Corrections
The following program corrections appear in this release:

1. Harmonic Analysis

• Harmonic Analysis GUI dialog did not correctly set integer arguments of har_analysis_2 API. This is
corrected.

7.7. Known Issues
The following issues have been identified and known to exist in this release:

1. None
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